Configurar a malha nos controladoresde LAN
sem fio Catalyst 9800
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I ntroduction

Este documento descreve um exemplo de configuragéo bésica sobre como unir um Ponto de Acesso (AP) de
malha ao Catalyst 9800 Wireless LAN Controller (WLC)

Prerequisites

Requirements

A Cisco recomenda que vocé tenha conhecimento destes topicos:

* Modelo de configuragéo Catalyst Wireless 9800

» Configuracdo de LAPs

» Controle e fornecimento de access points sem fio (CAPWAP)
» Configuracdo de um servidor DHCP externo

» Configuracdo de switches Cisco

Componentes Utilizados

Este exemplo usa o ponto de acesso lightweight (1572AP e 1542) gque pode ser configurado como um Root
AP (RAP) ou Mesh AP (MAP) parase unir ao Catalyst 9800 WLC. O procedimento é idéntico para 1542 ou
1562 pontos de acesso. O RAP é conectado ao Catalyst 9800 WL C através de um switch Cisco Catalyst.

As informagdes neste documento sdo baseadas nestas versdes de software e hardware:

C9800-CL v16.12.1

Switch de Camada 2 da Cisco

Pontos de acesso Cisco Aironet série 1572 Lightweight Outdoor para a secdo Bridge
Cisco Aironet 1542 para a secéo Flex+Bridge



Theinformation in this document was created from the devicesin a specific lab environment. All of
the devices used in this document started with a cleared (default) configuration. Se a rede estiver
ativa, certifique-se de que vocé entenda o impacto potencial de qualquer comando.

Configurar

Estudo de caso 1: Modo em bridge
Diagrama de Rede
Configuracbes

Um AP de malha precisa ser autenticado para que ele se una ao controlador 9800. Este estudo de caso
considera que voceé se une ao AP no modo local primeiro parao WL C e depois o converte para 0 modo de
malha Bridge (também conhecido como).

Para evitar a atribuicdo de perfis de juncéo de AP, use este exemplo, mas configure o0 método default aaa
authorization credential-download para que qualquer AP de malha tenha permissao para se unir a
controladora.

Etapa 1. Configure os enderecos MAC RAP/MAP em Autenticacdo de dispositivo.

VaparaConfiguration > AAA > AAA Advanced > Device Authentication .
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Adicione o endereco MAC Ethernet base dos pontos de acesso da malha, adicione-o sem caracteres

Importante: a partir da versdo 17.3.1, iSe agum delimitador de enderego MAC, como ', ' ou '-', for
adicionado, o AP ndo podera se unir. No momento, ha 2 aprimoramentos abertos paraisso: 1D de bug
Cisco CSCvv43870 e ID de bug Cisco CSCvr07920. No futuro, 0 9800 aceitara todos os formatos de

endereco mac.



https://tools.cisco.com/bugsearch/bug/CSCvv43870
https://tools.cisco.com/bugsearch/bug/CSCvv43870
https://tools.cisco.com/bugsearch/bug/CSCvr07920

Quick Setup: MAC Filtering

MAC Address*

Artribute List Mame

|. o Cancel |

Etapa 2: Configurar alista de métodos de autenticacdo e autorizacéo.

VaparaConfiguration > Security > AAA > AAA Method list > Authentication e crie alista de métodos
de autenticacdo e alista de métodos de autorizacao.



Quick Setup: AAA Authorization

Method List Name* Mash_Authz

Type* credential-download »

Group Type _ local v

Authenticated |:|

Available Server Groups Assigned Server Groups

radius

Idap L
tacacs+

ISE-Group .
ISE_grp_|2

I




Quick Setup: AAA Authentication

Method List Mame® | Mesh_authentication |

Type* [ dotlx v |

Group Type [ local L] |

Available Server Groups Assigned Server Groups

radius
Idap L
tacacs+ -
ISE-Group

ISE_grp_l2

|

Etapa 3: Configure os parémetros globais de maha.

Vapara Configuration> Mesh> Global parameters. Inicialmente, podemos manter esses valores como
padréo.
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Etapa 4: Crie um novo Perfil de Malhaem Configuracéo > Malha > Perfil > +Adicionar
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Add Mesh Profile

General Advanced
Mame=® Mash_PmﬁH Backhaul amsdu
Description Enter Description Backhaul Client Access [
Battery State for an AP [+]
Range (Root AP to Mesh AP) 12000
. : Full sector DFS status
Multicast Mode In-Out . |

IDS (Rogue/Signature Detection) D

Convergence Mathod ' Standard v I
Background Scanning ]
Channel Change Notification D
LSC L]

Cligue no perfil de malha criado para editar as configuragtes Geral e Avangado do perfil de malha

No diagrama como mostrado, precisamos mapear o perfil de autenticagéo e autorizagdo criado antes para o
perfil Mesh



General Advanced

Eecunity 5 GHz Band Backhaul
hethod EAP = Rate Typas auto
‘ : 2.4 GHz Band Backhaul
Authantication Methad Mesh_Authentication «»
Autharization Method Mesh_Authz v . Rate Types auto
Ethernet Bridaing
VLAN Transparent |7|
Ethernet Bridging O
Bridge Group
Bridge Group Mame Enter Name
Strict Match ]

Etapa 5: Criar um novo perfil dejuncdo AP. Vapara Configure> Tags and Profiles: AP Join.
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Add AP Join Profile

General Client caPwap AP Management Rogue AP ICap

—
Description ‘ Enter Description ‘
LED State

LAG Mode ]

NTP Server 0.0.0.0

!

Aplique o perfil de malha configurado anteriormente e configure a autenticagdo EAP AP AP:




Add AP Join Profile

General Client CAPWAP Management Rogue AP ICap

Hyperlocation BLE Packet Capture

Power Over Ethernet Client Statistics Reporting Interve
Switch Flag [] 5 GHz (sec) 90
Power Injector State D 2.4 GHz (sec) 90
Power Injector Type Unknown -
' ) Extended Module

Injector Switch MAC 00:00:00:00:00:00

Enable ]
Code

Mesh
AP EAP Auth Configuration )

Profile Name Mesh_Profi
EAP Type " EAP-FAST v |
AP Authorization Type CAPWAP DTLS v|

0

Etapa 6: Crie umatag de localizagdo de malha como mostrado.
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Configure (Configurar) Clique na TAG de localizag@o da malha criada na Etapa 6 para configuré-la.

Chegou até a guia Site e aplique o Perfil de juncéo de AP do Mesh configurado anteriormente aele:
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Add Site Tag

Mame* Mesh_aAP_tag

Description Enter Description

Control Plane Name

AP Jaoin Profile Mesh _..E'dF'__Ir::ir1_|:=ru::ﬁI L I

L

Enable Local Site

Passo 7. Convertao AP para o modo Bridge.

Configuration - » Wireless~ » Access Points

% All Access Points

Number of AP(s): 1

AP L Admin
AP MName ~  Maodel Slots  ~  Status
AlR=
AP?CQE—‘HGE—EBB; AP1562E- 2 ®
E-K3
4 14 1 * . 10 » . tems per page
5 GHz Radios
2.4 GHz Radios

Dual-Band Radios

viaCLI, vocé pode usar este comando no AP:

L

Edit AP

124
Address

109,129.193

General Interfaces

General

AP Name*®

Location®

Base Radio MAC

Ethernet MAC

Admin Status

AP Mode

Operation Status

Fabric Status

LED State

High Availability Inventory

| AP2C33-110E-6B66

' defaut location

7070.8bb4.9200

2033.110e.6066

| eridge v

Manitar
Sensor
Sniffer

Claar



capwap ap mode bridge

O AP éreinicializado e volta como modo de Bridge.

Etapa 8. Agoravocé pode definir afungdo do AP: AP raiz ou AP de maha

O AP raiz é aquele com uma conexdo com fio a WL C, enquanto o AP de malha se une aWLC através de

seu radio que tenta se conectar aum AP raiz.

Um AP de malha pode se unir a WL C através de suainterface com fio depois que ele ndo conseguir
encontrar um AP raiz através de seu rédio, para fins de provisao.

Configuration = * Wireless~ » Access Points

% All Access Points
Mumber of AP(z): 1
AP L Admin ~ P
AP Mama ~  Model Slots  ~  Status Addrass
AP2C33-110E-6866 4
Al | APISE2E- 2 ® 109.129.49.9
1t
E-K9
1 10 »

5 GHz Radios

General Interfaces High Availability Inventory Mesh £
General Ethernet Port Co
Block Child 0 Ethemnet Brdg
enabled 1o -.’t(.ll'lllg
Daisy Chaining
Daisy Chaining strict- Part
RAP
Mode

Preferred Parant MAC | 0000.0000.0000

WLAN Trunking Mative 1

Rale Mesh -
2.4 GHz Radios oot
Dual-Band Radios Remouve POK )
Country Backhaul
LSC Provision Backhaul Radio Type | Sahz r
Backhaul Slot 1D 1 v
Rate Types D v
D CGancel
Verificar
aaa new-model
aaa local authentication default authorization default

authentication dotlx default local
authentication dotlx Mesh_Authentication local

aaa
aaa



aaa authorization network default local
aaa authorization credential-download default local
aaa authorization credential-download Mesh_Authz local
username 111122223333 mac
wireless profile mesh Mesh_Profile
method authentication Mesh_Authentication
method authorization Mesh_Authz
wireless profile mesh default-mesh-profile
description "default mesh profile"
wireless tag site Mesh_AP_Tag
ap-profile Mesh_AP_Join_Profile
ap profile Mesh_AP_Join_Profile
hyperlocation ble-beacon @
hyperlocation ble-beacon
hyperlocation ble-beacon
hyperlocation ble-beacon
hyperlocation ble-beacon
mesh-profile Mesh_Profile

A WN R

Troubleshoot

Na pagina Troubleshooting > Radioative Trace da Ul daWeb, clique em adicionar einsira o endereco
MAC do AP.

Add MAC/IP Address

MAC/IF Addrass*

= Cancel

Clique em Start e aguarde até que o AP tente se unir ao controlador novamente.

Depois de concluido, clique em Gerar e escolha um periodo de tempo para coletar os logs (Ultimos 10 ou 30
minutos, por exemplo).

Cligue no nome do arquivo de rastreamento para baixa-1o do seu navegador.

Aqui esta um exemplo de AP ndo ingressado devido ao nome incorreto do método de autorizacdo aaa
definido :



019/11/28 13:08:38.269 {wncd_x_R@-0}{1}:

2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28
2019/11/28

13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:
13:

08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:
08:

38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.
38.

288
288
288
288
288
288
288
288
288
288
288
288
288
288
288
288
288
289

{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:
{wncd_x_R0-0}{1}:

[capwapac-smgr-srvr] [23388]:

{wncmgrd_R0O-0}{1}:

(info): Session-IP: 192.168.88.4¢
[ewlc-infra-evq] [23388]: (info): DTLS record type: 23, applit
[capwapac-smgr-sess] [23388]: (info): Session-IP: 192.168.88.-
[capwapac-smgr-sess] [23388]: (info): Session-IP: 192.168.88.-

[mesh-config] [23388]: (ERR): Failed to get ap PMK cache rec :
[mesh-config] [23388]: (ERR): Failed to get ap PMK cache rec :
[mesh-config] [23388]: (ERR): Failed to get ap PMK cache rec :

[apmgr-capwap-join] [23388]: (info): ©00a3.8e95.6c40 Ap auth pe
[apmgr-capwap-join] [23388]: (ERR): Failed to initialize authc
[apmgr-capwap-join] [23388]: (ERR): 00a3.8e95.6c40 Auth reque:
[apmgr-db] [23388]: (ERR): 00a3.8e95.6c40 Failed to get wtp re
[apmgr-db] [23388]: (ERR): 00a3.8e95.6c40 Failed to get ap tac
[capwapac-smgr-sess-fsm] [23388]: (ERR): Session-IP: 192.168.¢
[capwapac-smgr-sess-fsm] [23388]: (info): Session-IP: 192.168
[capwapac-smgr-sess-fsm] [23388]: (note): Session-IP: 192.168
[capwapac-smgr-sess-fsm] [23388]: (note): Session-IP: 192.168
[ewlc-dtls-sessmgr] [23388]: (info): Remote Host: 192.168.88.-
[ewlc-dtls-sessmgr] [23388]: (info): Remote Host: 192.168.88.-

[ewlc-infra-evq] [23038]: (debug): instance :0@ port:38932MAC:

O mesmo pode ser visto mais facilmente no painel dainterface do usuario da Web quando se clicaem APs
ndo ingressados. "Autenticacdo de AP pendente" é a dica que aponta para a autenticacéo do préprio AP:

Join Statistics

Monitoring = >

Genera

Number of AP{s): 2

Jaoin Statistics

Status “15 equal to® NOT JOINED

AP Nama

APICFR=9BSF=TDT0

M

10«

Wireless~ » AP Statistics

) ¥

~ AP Mod

Co1208/

d
=

General Statistlcs
DTLS Session requeast receved 1 Canfhguration
Established DTLS session 1 Successful oo
FESPONSas So
Unsuccessful DTLS sassion 4]
Unsuccessiul
request proce
Reagon for last unsuccessiul DTLS DTLS Handshake
session Success
Reason for |a:
- configuration
Time at last successful DTLS session Mon, 17 Feb 2020
08:15:41 GMT )
Time at last 5
- configuration
Time at last unsuccessiul DTLS M
session
Time at last w
configuration
Join phase statistics
Data DTLS !
Jain requests recaived 1
DTLS Sessior
Successful join responses sent a
Established D
Unsuccesshul jon requast procassing a

Unzuccessiul

Reason for last unsuccessiul join Ap auth pending

atternpt
Reason for la:
) DTLS session
Time at last successiul join attempt M
Time at last s
Time at last unswccessiul join attempt W& session
Time at last u

Session



Access Point Join Summary

-

B Joined B Not Joined

Estudo de caso 2: Flex + Bridge

Esta se¢éo destaca o processo de unido de um AP 1542 no modo Flex+bridge com autenticag@o EAP feita
localmente no WLC.

Configurar

» Etapal. Navegue até Configuration > Security > AAA > AAA Advanced > Device Authentication



Configuration~ > Security ~ > AAPb

+ AAA Wizard
Servers [ Groups AAA Method List |AM Advanced é
Global Config

MAC Address Serial Number

RADIUS Fallback

1 Add
Attribute List Name 4

|| Device Authe nticatioé MALSirasses

002ccB8dez2bd0

» Etapa 2. Selecione Device Authentication e Add
» Etapa 3. Digite o0 endereco MAC Ethernet base do AP paraingressar naWLC, deixe o nome da lista
de atributos em branco e selecione Apply to Device

Quick Setup: MAC Filtering

MAC Address* FFF. FFFF. FFIF ||

Attribute List Name qwone v |

=1 Apply to Device

» Etapa4. Navegue até Configuration > Security > AAA > AAA Method List > Autenticagéo
» Etapab. Selecione Add, o pop-up AAA Authentication sera exibido




s

+ AAA Wizard

Configuration ™ > Security ™ > AAAo

Servers [ Groups | AAA Method List ‘ AAA Advanced
| -+ Add

x‘mtwewt'ca:c-é

Authorization

Accounting

4

Name

webauth-local-login

» Etapa 6. Digite um nome no Nome da lista de métodos, selecione 802.1x nalista suspensa Tipo* e

local parao Tipo de grupo, finalmente selecione Aplicar ao dispositivo

Quick Setup: AAA Authentication 1

Method List Name® mesh-ap|
Type™ dot1x
Group Type local

Available Server Groups

radius

Idap

tacacs+
imarquez-Radius-grp

Assigned Server Groups

» Etapa 6b. Caso seus APs entrem diretamente como modo de Bridge e ndo tenham recebido uma marca
de site e politica antes, repita a etapa 6, mas para 0 método padréo.
 Configure um método de autenticacdo dot1x aaa que aponte paraloca (CLI aaa authentication dot1x

defauilt local)

» Passo 7. Navegue até Configuration > Security > AAA > AAA Method List > Autorizacéo

 Etapa8. Selecione Add, o pop-up AAA Authorization seré exibido



Configuration™ > Security ™ > AAAB

+ AAA Wizard

Servers [ Groups AAA Method List AAA Advanced

Authentication

| . e + Add |
Authorization 'h o

Accounting Mame

default

 Etapa9. Digite um nome no Nome da lista de métodos, selecione o download credencial nalista
suspensa Tipo* elocal parao Tipo de grupo, finalmente selecione Aplicar ao dispositivo

Quick Setup: AAA Authorization

Method List Name* | mesh-ap |p
Type™ | credential-download « | e
Group Type | local v e
Authenticated
Available Server Groups Assigned Server Groups
radius
ldap =
tacacs+

imarquez-Radius-grp

 Etapa 9b. Caso seu AP se una diretamente no modo Bridge (isto &, ele ndo se une primeiro no modo
local), repita a etapa 9 para 0 método padréo de download de credencial (CLI aaa authorization
credential-download default local)

 Etapa 10. Navegue até Configuration > Wireless > Mesh > Profiles

» Etapa 11. Selecione Add, o pop-up Add Mesh Profile serd exibido




|Cor1ﬁguratiﬂr1' > Wireless~ > Mesh

Global Config >

» Etapa12. Naguia Geral, defina um nome e uma descricéo para o perfil Mesh

Add Mesh Profile

General Advanced
Mame* | mesh-profilg| |
Description | mesh-profile |

» Etapa 13. Naguia Advanced, selecione EAP parao campo M ethod
» Etapa 14. Selecione o perfil de Autorizagdo e Autenticacéo definido nas etapas 6 e 9 e selecione
Aplicar ao Dispositivo



Add Mesh Profile

General |Advam:ed

Security
Method | EAP v |
Authentication Method | mesh-ap v |
Authorization Method | mesh-ap| v |
Ethernet Bridging
VLAN Transparent v
Ethernet Bridging
Bridge Group
Enter Mame

Bridge Group Name

Strict Match

 Etapa15. Navegue até Configuration > Tag & Profiles> AP Join > Profile

5 GHz Band Backhaul

Rate Types

2.4 GHz Band Backhaul

Rate Types

» Etapa 16. Selecione Add, o pop-up AP Join Profile serd exibido, defina um nome e uma descri¢éo

para o perfil de AP Join

Configuration~ > Tags & Profiles~ > AP Join

AP Join Profile Mame



Add AP Join Profile

General Client CAPWAP AP Management Rogue AP ICap

MNarme® | mes-ap-join |
Description | mesh-ap-join| |
LED State o

LAG Mode

MNTP Server 0.0.0.0

» Etapa 17. Navegue até aguia AP e selecione o Perfil da malha criado na etapa 12 no menu suspenso

Nome do perfil da malha
» Etapa18. Certifique-se de que EAP-FAST e CAPWAP DTL S estgjam definidos para os campos

Tipo de EAP e Tipo de autorizagéo de AP, respectivamente
» Steo 19. Selecione Aplicar ao dispositivo



Add AP Join Profile

General Client CAPWAP AP ‘n Management Rogue AP ICap

General Hyperlocation BLE Packet Capture
Power Over Ethemet Client Statistics Reporting Inte
Switch Flag 5 GHz (sec) | 90
Power Injector State 2.4 GHz (sec) | a0
Power Injector Type | Unknown v | Extended Module
Injector Switch MAC | 00:00:00:00:00:00 | Enable
Code

| | Mesh
AP EAP Auth Configuration B

Profile Name mesh-p

EAP Type | EAP-FAST v
AP Authorization Type | CAPWAP DTLS v |p

 Etapa 20. Navegue até Configuracdo > Tag & Profiles> Tags > Site
» Etapa2l. Selecione Add, ajanela pop-up Site Tag serd exibida

Configuration~ > Tags & Profiles~ > Taa

Policy Site b RF AP

» Etapa 22. Digite um nome e uma descricdo paraa Marca de Site




Add Site Tag 1

Mame® mesh-ap-site

Description mesh-ap-site

AP Join Profile | m'ESh‘ED-jGin-prohIE' v i

» Etapa23. Selecione o Perfil dejuncéo AP criado naetapa 16 no menu suspenso Perfil dejuncéo AP

» Etapa24. Naparte inferior do pop-up Marca do site, desmarque a caixa de selecéo Habilitar site
local para habilitar o menu suspenso Perfil do Flex.

 Etapa 35. No menu suspenso Flex Profile, selecione o Flex Profile que desgja usar parao AP

Add Site Tag

Marme® mesh-ap-site

Description mesh-ap-site

AP Join Profile mesh-ap-join-profile »

Flex Profile imarquez-FlexLocal .. e
Control Plane Name v

Enable Local Site _n

» Etapa 36. Conecte o AP arede e verifique se 0 AP estd no modo local.
» Etapa 37. Paragarantir que o AP esteja no modo local, emita o comando capwap ap mode local.

O AP deve ter uma maneira de encontrar a controladora, broadcast L2, DHCP Opgéo 43, resolucédo
DNS ou configuragéo manual.

» Etapa38. O AP seunea WLC, verifique se esta listado nalista de APs, navegue para Configuration
> Wireless > Access Points > All Access Points



Configuration~ > Wireless~ > Access Points b

W All Access Points

Number of AP(s): 2

Total +  Admin v Base Radio « AP
AP Name ~  Slots Status AP Model ~  MAC Mode
2 (] Flex+Bridge

2 (] B Local e

» Etapa 39. Selecione o AP, o pop-up AP seraexibido.
» Etapa40. Selecione aguia Site Tag criada na Etapa 22 em Geral > Tags > Site no pop-up AP,
selecione Atualizar e aplicar ao dispositivo



Edit AP

' |l Interfaces High Awvailability Inventory Mesh Advanced

General Version

AP Mame™ | M iEl | Primary Software Version 16.12.1.1
Location™ | default location | Predownloaded Status N/A

Base Radio MAC i Predownloaded Version N/A
Ethernet MAC Next Retry Time N/A
Admin Status [ENABLED .] Boot Version 1.1.2.4
AP Mode | wn g . | IOS Version 16.12.1.1°
Operation Status Registered Mini IOS Version 0.0.0.0
Fabric Status Disabled IP Config

HED State [EWLED .] CAPWARP Preferred Mode  IPvd

LED Brightness 8 | DHCP IPv4 Address

CleanAir NSI Key Static IP (IPv4/IPvé)

Tags Time Statistics

Policy | imarquez-FlexlLocal | » Up Time ﬁ.l I[:I'I?S
Site | Mesh-AP-Tag v e Controller Association Latency 20's
RF | default-rf-tag v |

» Etapa4l. O AP éreinicializado e deve se unir de voltaao WL C no modo Flex + Bridge

Observe que esse método junta o AP primeiro no modo local (onde ndo faz a autenticacdo dot1x) para
aplicar amarca de site com o perfil de malha e, em seguida, comuta o AP para 0 modo de ponte.



Para unir um AP que esta preso no modo Bridge (ou Flex+Bridge), configure os métodos padréo (aaa
authentication dot1x default local e aaa authorization cred default local).

O AP é entdo capaz de autenticar e vocé pode atribuir as tags depois.
Verificar

Certifique-se de que 0 modo AP segja exibido como Flex + Bridge, conforme mostrado nesta imagem.

Configuration~ > Wireless~ > Access Points

W All Access Points

Number of AP(s): 2 I})
Total ~  Admin vi Base Radio « AP
AP Name ~  Slots Status AP Model ~  MAC Mode
2 0 AIR-AP15421-A-K9 - miwm e Flex+Bridc

Execute esses comandos da CLI do WL C 9800 e procure o atributo AP Mode. Ele deve estar listado como
Flex+Bridge

aaa authorization credential-download mesh-ap local
aaa authentication dotlx mesh-ap local

wireless profile mesh default-mesh-profile
description "default mesh profile"

wireless tag site meshsite
ap-profile meshapjoin

no local-site

ap profile meshapjoin
hyperlocation ble-beacon
hyperlocation ble-beacon
hyperlocation ble-beacon
hyperlocation ble-beacon
hyperlocation ble-beacon
mesh-profile mesh-profile

A WNEOS

Troubleshoot

Certifique-se de que os ecommands aaa authentication dot1x default local e aaa authorization cred
default local estejam presentes. Eles so necessarios se 0 seu AP ndo tiver sido pré-ingressado no modo
Local.

O painel principal do 9800 tem um widget que exibe 0s APs que ndo podem se unir. Clique nele para obter
umalistade APs que falham ao ingressar:



Monitoring = » Wireless - > AP Statistics
General Join Statistics

Kumbor of AP(s): 2

5 15 equad o NOT = %
Satus  ~  Base Radio MAC +  Ethemmat MAG « AP Name
4] 1003, cf23 SdB0 2cd8.9621. 18b0 APICFEGE21 1880
[+ ] T070.8bb4.9200 % 2c33.1108.6b6E APICI3.110E. 66866
1 10

Cligue no AP especifico paraver o motivo pelo qual ele ndo ingressou. Nesse caso, vemos um problema de
autenticacdo (autenticacdo de AP pendente) porque a marca do site ndo foi atribuidaao AP.

Portanto, 0 9800 ndo escolheu 0 método de autenti cagcdo/autorizacdo nomeado para autenticar o AP :



Join Statistics

General Stattistics

Control DTLS Statistics

DTLS Session request received
Established DTLS session
Unsuccessful DTLS session

Reason for last unsuccessful DTLS
session

Time at last successful DTLS session

Time at last unsuccessful DTLS
session

Join phase statistics

Join requests received
Successful join responses sent
Unsuccessful join request processing

Reason for last unsuccessful join
attempt

Time at last successful join attempt

Time at last unsuccessful join attempt

179

179

DTLS Handshake
Success

Thu, 19 Dec 2019
13:03:19 GMT
NA

179

173

0

Ap auth pending

Thu, 19 Dec 2019
12:36:10 GMT

MNA

Configuration phase statistic

Configuration requests received

Successful configuration
responses sent

Unsuccessful configuration
request processing

Reasaon for last unsuccessful
configuration attempt

Time at last successful
configuration attempt

Time at last unsuccessful
configuration attempt

Data DTLS Statistics

DTLS Session request received
Established DTLS session
Unsuccessful DTLS session

Reason for last unsuccessful
DTLS session

Time at last successful DTLS
session

Time at last unsuccessful DTLS
session

Para Troubleshooting mais avancado, va para a pagina Troubleshooting > Radioative Trace nainterface
de usuério da Web.

Sevocé inserir 0 endereco MAC do AP, podera gerar imediatamente um arquivo para obter os logs sempre
ativos (no nivel de aviso) do AP que tenta juntar-se.

Cligue em Iniciar para habilitar a depuracéo avancada para esse endereco mac. Na proxima vez que os logs
forem gerados, gere os logs, 0s logs de depuragdo para a juncdo do AP serdo mostrados.



B .l Cisco Catalyst 9800-CL Wireless Controller

CISCO 16.12.1

a Troubleshooting - > Radioactive Trace

+ Back to TroubleShooting Menu

) Dashboard

Conditional Debug Global State: Stopped

+ Start

Configuration
MAC/IP Address Trace file

Ad ministration ? 2c33.110e.6b66 debugTrace_2c33.110e.6b66. 1t &

’ Troubleshooting L 10 v




Sobre esta tradugao

A Cisco traduziu este documento com a ajuda de tecnologias de tradugéo automatica e
humana para oferecer conteudo de suporte aos seus usuarios no seu proprio idioma,
independentemente da localizagao.

Observe que mesmo a melhor tradugao automatica nao sera tao precisa quanto as realizadas
por um tradutor profissional.

A Cisco Systems, Inc. ndo se responsabiliza pela precisdo destas tradugdes e recomenda
que o documento original em inglés (link fornecido) seja sempre consultado.



